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1 Installation and technical requirements
VCF.Filter is a Java desktop tool that requires Java version 1.8 to be installed on the computer where you
wish to run it. To see if Java is installed properly on your system, open a command line prompt and type:
java -version
The output should read similar to this:
java version "1.8.0_101"
If the java command is not recognized, you have to install Java and/or make Java part of your PATH
environment variable. Details on how to install Java can be found at the Java download website
http://www.java.com.
Once Java works properly, visit https://biomedical-sequencing.at/VCFFilter/ and download the file
VCFFilter_with_sample_data.zip
Make sure that the file is saved with the .zip ending. Unzip the file in a
directory of your choice. You should see the files shown in Fig. 1.1 in the
directory, which includes three start-up scripts for three different operating
systems (Fig. 1.2).

Figure 1-1: Directory structure of the unzipped VCF.Filter
package.

Depending on the operating system you are using, double click the appropriate start-up script.

Windows runVCFFilter.bat
MacOS
runVCFFilter.command
Linux
runVCFFilter.sh
Figure 1-2: VCF.Filter start-up scripts

Please note that the script may need to be rendered executable
(chmod a+x runVCFFilter.sh). VCF.Filter is started with 1 GB of
memory to be reserved for the Java virtual machine. If your
computer has little memory, you can modify the start-up
parameters from -Xmx1024m to –Xmx516m or less. However,
larger VCF files may not be analyzable when memory is limiting.

Double-clicking the start-up script will launch the start-up wizard that allows you to load an example VCF
file, as described in the next section.
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2 First start
2.1 Quick start guide
1.
2.
3.
4.
5.
6.

Download and unzip the VCF.Filter package in a directory of your choice
Double click the start-up script (required is a valid Java 1.8 installation on your computer)
In the start-up wizard, open a valid VCF file
In the start-up wizard, press “Start VCFFilter”
You can now open VCF files and apply filters for every VCF Info headerline
Use the Example buttons to see immediate analysis results

2.2 Defining an example VCF file
In order to perform filtering, VCF.Filter needs an example VCF file with valid header lines that are used to
initialize filters appropriate for each annotated field. The path to this example file is written in a
VCF.Filter_preferences.ini file and the example VCF file will be read each time VCF.Filter is started. When
you first start VCF.Filter or when the example VCF file cannot be located, a wizard is shown that prompts
you to navigate to an example VCF file and then to start VCF.Filter (Figure 2.1).

Figure 2-1: Welcome screen
After choosing a properly formatted and indexed VCF file, the “Start VCFFilter” button turns green. Click to start VCF.Filter.

2.3 Modifying the example VCF file path in VCF.Filter preferences
Many parameters that determine VCF.Filter operations are determined in the preferences. To open the
preferences wizard, select “File” -> “Preferences” as shown in Figure 2.2.

Figure 2-2: The Preferences menu option
Use the preferences to customize VCF.Filter settings.

To change the example VCF file, in the preferences Files tab click Example VCF file “Open” as shown in
Figure 2.3
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Figure 2-3: Choosing the example VCF file
The example VCF file is indispensable for proper function of VCF.Filter and must be changed
each time a VCF headers of the cohort VCF files is missing in the example VCF file.
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3 Running VCF.Filter
3.1 Analysis types
VCF.Filter offers three types of analyses: Filter variants, Family analysis, and Search variants. Each type of
analysis has its own tab (Figure 3.1) and will be described
in more detail in the following paragraphs. Filter variants
permits loading a set of VCF files, apply a set of filters, and
arrive at a set of variants that pass all filters. Family
analysis, in addition, permits defining family relationships
between affected and unaffected individuals and serves to Figure 3-1: VCFFilter main tabs.
determine candidate variants causing disease phenotypes.
There is one tab for each type of analysis.
The Search variants function instead permits starting from
a set of known variants and finding VCF files where those variants are present. Two of the analysis types
require defining filters (Filter variants and Family analysis), which will be described in the next section.

3.2 Defining filters
VCF.Filter allows defining filters for all fields defined as INFO headerlines and for the general fields
CHROM, POS, ID, REF, ALT, QUAL, and FILTER. Filters are added or removed using the “Filter options” ->
“Single filter options” pull down menus shown in Figure 3.2. For each filter, the field ID, the number of
values, the data type, and a brief description are shown. Clicking “Add” will add a filter to the Filters area
of VCF.Filter. To remove a filter, you can use the pulldown menu in Figure 3.2, locate the filter, and press
“Remove” or the Remove button that comes with each filter (shown in Figure 3.3 and Figure 3.4).

Figure 3-2: Filter options
Choose a VCF header line from the pull down menu and click “Add” to add a filter for its values.
Choose a VCF header line from the pull down menu and click “Remove” to remove a filter for its values.

You can define up to ten filters and combine them in a filter chain using logical AND / AND NOT. Each filter
has fields for three criteria that are linked in a logical OR operation. In other words, the filter is passed
when one of the three criteria is met. For filtering on numeric values, a single letter operator must be
defined (one of >, =, < but not >=, <=) prior to the number being filtered on. For text based filtering,
operators are not needed. Whether a filter requires operators or not can be determined using the mouseover tool tip function for the criteria fields of a given filter. The ID field of the filter is also equipped with
a tool tip function and displays the description text of the filter. The tool tip functions of filters are shown
in Figure 3.3 to 3.5

7

Figure 3-3: Text filter tooltip example
Text values don’t need operators. Wild card character * is permitted.

Figure 3-4: Number filter tooltip example
Number filters must be preceded by a single letter operator (>, <, =)

Figure 3-5: Filter ID tooltip example
Hovering over the filter ID displays the VCF header line description in a tooltip.

The set of filters along with the search criteria can be saved as a filter scenario (.fsc).
Figure 3-6: Filter scenarios
Filter chains including all search criteria can be saved to file and loaded from file.

3.3 Filter variants
3.3.1 Open, add, and remove VCF files
VCF files can be loaded using the “Open VCF files” button. Opening a new set of VCF files replaces any VCF
files that had been loaded previously. When VCF files are
located in different directories, you can use the pop-up menu
option “Add more” to add additional VCF files without replacing
the VCF files that were already loaded. The pop-up menu is
activated by pressing the right mouse button in the list that
displays VCF file names. (Figure 3.7). To remove all VCF files,
click “Clear” in the pop-up menu.

Figure 3-7: Pop-up menu example

Once VCF files are loaded, the “Run” button will turn green.
When “Run” is clicked, VCF.Filter will process all VCF files that
are highlighted in the file list (See Figures 3.8. and 3.9). In the
absence of valid filters, the contents of the VCF files will be
displayed sorted by variant chromosome and start position.
8

Figure 3-8: Highlighted VCF files are processed.
Files 1148.vcf.gz and 1149.vcf.gz will be
processed.

Figure 3-9: Highlighted VCF files are processed.
Only file 1148.vcf.gz will be processed

3.3.2 Open, add, and remove inclusion lists (variants to be kept)
Inclusion are lists of genomic regions whose variants should be
reported in the output. Regions of interest might be constituted by
runs of homozygosity in the genome of children of consanguineous
marriages. Inclusion lists can be defined in browser embedded
data format (.bed) or PLINK .hom files. To load inclusion list files,
press “Open” in the Inclusion lists field. Activate the pop-up menu
by right clicking the mouse in the file list field to add more inclusion
list files or to clear the file list (see Figure 3.10). When the “Run”
button is clicked, all inclusion list files that are highlighted are Figure 3-10: Only highlighted inclusion list
aggregated into one set of regions using logical OR operations. This files are processed.
means that any region of the genome covered by at least one
inclusion list file will be reported in the output when variants are found in that region. Please note that
the coordinates used by the VCF parser are inclusive. When you have a variant at position chr1:1000, all
these coordinates in a bed file will work to find the variant:
Chr1:999-1000
Chr1:1000-1000
Chr1:1000-1001

3.3.3 Open, add, and remove exclusion lists (variants to be discarded)
Exclusion lists are lists of genomic regions whose variants should
not be reported in the output. Such regions might be composed of
known reference assembly errors and can serve to avoid highly
recurrent variants from being reported. Exclusion lists can be
defined in browser embedded data format (.bed) or PLINK .hom
files. To load exclusion list files, press “Open” in the Exclusion lists
field. Activate the pop-up menu by right clicking the mouse in the
file list field to add more exclusion list files or to clear the file list Figure 3-11: Only highlighted exclusion list
files are processed.
(see Figure 3.11). When the “Run” button is clicked, all exclusion
list files that are highlighted are aggregated into one set of regions
using logical OR operations. This means that any region of the genome covered by at least one exclusion
9

list file will not be reported in the output when variants are found in that region. Exclusion listed regions
overrule inclusion listed regions. Please note that the coordinates used by the VCF parser are inclusive.
When you have a variant at position chr1:1000, all these coordinates in a bed file will work to exclude the
variant:
Chr1:999-1000
Chr1:1000-1000
Chr1:1000-1001

3.3.4 Open, add, and remove cohort frequency files
VCF.Filter can calculate variant cohort frequency in a cohort of
samples (see below) that can be stored in a cohort frequency file
in tab separated values format (.tsv). Cohort frequency files can
be loaded by clicking the “Open” button in the Cohort frequency
field. More cohort frequency files can be loaded by activating the
pop-up menu and using the “Add more” option. To clear the list
of cohort frequency files, use the “Clear” option in the pop-up Figure 3-12: Only the highlighted cohort
menu (see Figure 3.12).
frequency file is processed.

Figure 3-13: Cohort frequency cutoff

Only one cohort frequency file can be highlighted in the file list at
the same time. The highlighted cohort frequency file is used for
filtering variants using the cohort frequency cutoff shown in
Figure 3.13. The cohort frequency number is the number of alleles
for this variant present in your cohort, i.e. homozygous variants
are counted twice. Filtering can be done separately on the total
number of alleles, or the number of hetero-/homozygous alleles
in the cohort.
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3.3.5 Filter variants Run options
3.3.5.1 Text output
In text output mode, which is activated by clicking “Text” in the
Output and controls section (shown in Figure 3.14), VCF.Filter
processes all VCF files that are highlighted in the “Input” file list,
combines highlighted inclusion lists into one common inclusion
list using logical OR operations on genomic regions, combines
highlighted exclusion lists into one common exclusion list using
logical OR operations on genomic regions, loads the highlighted
cohort frequency file, and performs filtering of VCF files taking Figure 3-14: Output and controls panel. Text
output is selected.
into consideration the filter chain defined in the Filters section,
inclusion listed regions, exclusion listed regions, and variant
cohort frequency according to the defined cohort frequency cutoff. The output is a list of variants sorted
by chromosome name and start position that is written to the output text area in tab separated values
format. The columns that are written to the output area as well as their order are defined by the VCF.Filter
preferences “Visible output” in the “Output format” tab.

Example output is shown in Figure 3.15

Figure 3-15: Text output example

The filter report contains the filters and criteria applied, the inclusion and exclusion list files used, the path
of the cohort frequency file, and the cohort frequency cutoff value. By hovering the mouse over the output
area, the user is reminded of the pop-up menu that can be used to save the contents of the output area
to a tab separated values file or to copy the contents to the clipboard for pasting into a spreadsheet
processing software tool. The user can also save the filtered variants as a bed file to be used as an inclusion
list at a later stage.
Please note that inclusion list filtering makes efficient use of the VCF index and is generally faster than the
default iteration over all variants in the VCF file.
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3.3.5.2

Write output to VCF file

In VCF file output mode, which is activated by clicking “VCF file”
in the “Output and controls” section shown in Figure 3.16, upon
pressing “Run” VCF.Filter prompts the user for an output file
name, processes all VCF files that are highlighted in the “Input”
file list, combines highlighted inclusion lists into one common
inclusion list using logical OR operations on genomic regions,
combines highlighted exclusion lists into one common exclusion
Figure 3-16: Output and controls panel. VCF file list using logical OR operations on genomic regions, loads the
output is selected.
highlighted cohort frequency file, and performs filtering of VCF
files taking into consideration the filter chain defined in the
Filters section, inclusion listed regions, exclusion listed regions, and variant cohort frequency according to
the defined cohort frequency cutoff. The output is a list of variants sorted by chromosome name and start
position that is written to the output text area in tab separated values format. The columns that are
written to the output area as well as their order are defined by the VCF.Filter preferences “Visible output”
in the “Output format” tab. The filtered variants are written to the output filename in VCF format and the
filter options that have been applied are added to the VCF header. The output is also written to the output
text area and can be saved or copied to a spreadsheet as described for the Text output option in the
previous section. Please note that the “Visible output” defined in the VCF.Filter preferences “Output
format” tab does not influence the contents of the resulting VCF file as all fields will be written to the
output VCF file. The output limit does not apply to the number of variants written to the output VCF file.

3.3.5.3 Calculate cohort frequency
Filtering on cohort frequency is a powerful way of eliminating
common variants and variants linked to ethnicity or reference
genome assembly errors. Calculating cohort frequency is
activated by clicking the “Cohort frequency” option in the
“Output and controls” section (See Figure 3.17) and loading as
well as highlighting all VCF files of the cohort under study.
Pressing “Run” will start processing of the cohort. Please note Figure 3-17: Output and controls panel.
that filters defined in the filter chain will be considered for cohort Calculate cohort frequency is selected.
frequency calculation but inclusion lists, exclusion lists, and
previously calculated cohort frequency files will have no effect. The output that appears in the output text
area after the cohort frequency calculation has finished should be saved to a tab separated values file
(.tsv) and can be loaded as a cohort frequency file in future filtering analyses. The cohort frequency file
format is shown in Figure 3.18.
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CHR POSITION REF
1
13224
G
1
16856
A
1
69428
T

ALT GENE FREQ HET FREQ HOM FREQ TOTAL
SAMPLES HET
SAMPLES HOM
A DDX11L1
2
0
2
[sample1, sample2]
[]
G WASH7P
3
0
3
[sample3, sample4, sample5]
[]
G OR4F5
1
2
3
[sample3]
[sample4]

Figure 3-18: File format of cohort frequency files. Files are stored as tab separated values files (.tsv).

3.3.5.4 Generate Hilbert curve
When the “Hilbert curve” option is active in the “Output and controls” section (See Figure 3.19), VCF.Filter
will perform the analyses in the same way as for the “Text” option and in addition it will draw the passing
variants onto a Hilbert curve. The Hilbert curve view of the
filtering results is useful to get a visual impression of the
distribution of the variant set over the genome. To ensure that
the same variant is located at the same position on the Hilbert
curve for different samples, the Hilbert curve is split into (2^curve
order)^2 sections, that correspond to genome length/(2^curve
order)^2 bases. The first variant falling into a given section of the
genome is drawn onto the Hilbert curve. Subsequent variants in
Figure 3-19: Output and controls panel.
Hilbert curve output is selected.
the same genome section will be ignored. The color used to draw
the variant is defined as A – red, C – green, G – blue, T – yellow
where A, C, G, and T are the first base of the variant allele.
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3.4 Family analysis
Family analysis, in addition to performing variant filtering as described for the Filter variants section,
permits defining parent - child relations for affected
individuals and uses unaffected individuals as an additional
control to filter out variants that do not follow the pattern
of inheritance of interest. Family analysis is located on the
second tab of VCF.Filter as shown in Figure 3.20
Figure 3-20: Family analysis tab

3.4.1 Open, add, and remove affected VCF files
VCF files of affected individuals can be loaded using the “Open
VCF files” button in the “Affected” section. Opening a new set
of VCF files replaces any VCF files that had been loaded
previously. When VCF files are located in different directories,
you can use the pop-up menu option “Add more” to add
additional VCF files without replacing the VCF files that were
already loaded. The pop-up menu is activated by pressing the
right mouse button in the list that displays VCF file names.
(Figure 3.21). To remove all VCF files, click “Clear” in the pop-up
menu. The user may also remove or keep selected files.
Figure 3-21: Open VCF files of affected
individuals.

As opposed to the Filter variants tab where only highlighted VCF
files were analyzed, during Family analysis all VCF files that are loaded will also be analyzed. This helps to
avoid confusion as individual VCF files may need to be highlighted for defining parent –child relationships
and it is easy to forget highlighting all the required VCF files before starting the analysis.

3.4.2 Open, add, and remove unaffected VCF files
VCF files of unaffected individuals can be loaded using the
“Open VCF files” button in the “Unaffected” section. Opening
a new set of VCF files replaces any VCF files that had been
loaded previously. When VCF files are located in different
directories, you can use the pop-up menu option “Add more”
to add additional VCF files without replacing the VCF files that
were already loaded. The pop-up menu is activated by pressing
the right mouse button in the list that displays VCF file names.
(Figure 3.22). To remove all VCF files, click “Clear” in the popup menu. The user may also remove or keep selected files.
Figure 3-22: Open VCF files of unaffected
individuals.
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3.4.3 Defining parent – child relationships
In order to perform segregation analysis, VCF.Filter must be instructed about the family relationships of
the individuals under study. After loading affected and unaffected VCF files, click the “View all
relationships” button to open the Relationships viewer (Figure 3.23). Choose the correct VCF files for the
mother and the father of the affected individual and define whether the affected individual is a male or a
female. Click “OK”. The relationships will be displayed in the “Relations” field when a single VCF file of an
affected individual is selected in the “Affected” field file list.

Figure 3-23: Relationships viewer

Please note that the unaffected individuals serve as negative controls for the filtered variants and do not
necessarily need to be relatives of the affected individuals.

3.4.4 Add and remove inclusion lists, exclusion lists, and cohort frequency files
In order to use list and /or cohort frequency filtering during family analysis, please activate the pop-up
menus to load respective files by right-clicking the mouse in the respective file list fields as shown in Figure
3.24 for the inclusion list case.
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Figure 3-24: Inclusion list pop-up menu

3.4.5 Interpreting family analysis filtering results
During family analysis, VCF.Filter searches for five types of potentially pathogenic variants: recessive
variants, dominant variants, compound heterozygous variants, X-linked variants, and de novo mutations.
The strategies for identifying these variants are discussed in detail below. Please note that the tables
below are not generated by VCF.Filter. Rather, they serve to illustrate that the output produced by
VCF.Filter during family analysis depends on the definition of affected and unaffected individuals. You can
use the provided test files child1, child2, mother, and father and try different combinations of affected
and unaffected individuals to see the effect.
3.4.5.1 Recessive variants
Disease-associated recessive variants are typically loss-offunction variants that must be present in a homozygous state
or paired with another non-functional allele (compound
heterozygous variants) in order to cause the disease.
VCF.Filter identifies recessive variants by requiring
homozygosity for the non-reference allele at a given genomic
position for all affected individuals and absence of
homozygosity in all unaffected individuals. Note that this
assumption requires 100% penetrance of the pathogenic
genotype. When mother and father of an affected individual
are defined, VCF.Filter ensures that the child genotype can be Figure 3-25: Segregation of recessive variants.
Pathogenic genotype is assumed to be A/A
assembled from the parent genotypes (segregation test).
Depending on the disease status of the parents, the
segregation test reports different combinations of child-parent genotypes as disease causing candidate
variants, as depicted in Figure 3.25.
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3.4.5.2

Dominant variants
Dominant variants are gain of function variants that can
cause disease in a heterozygous state. VCF.Filter
identifies dominant variants by requiring all affected
individuals to be carrier of the non-reference allele at a
given genomic position and absence of the same nonreference allele in all unaffected individuals. Note that
this assumption requires 100% penetrance of the
pathogenic genotype. When mother and father of an
Figure 3-26: Segregation of dominant variants.
Pathogenic genotype in child is assumed to be C/A. 1
indicates that C/A can be assembled from parent
genotypes. 0 indicates that C/A cannot be assembled
from the parent genotypes.

affected individual are defined, VCF.Filter
ensures that the child genotype can be assembled from the parent genotypes (segregation test).
Depending on the disease status of the parents, the segregation test reports different combinations of
child-parent genotypes as disease causing candidate variants, as depicted in Figure 3.26.

3.4.5.3 Compound heterozygous variants
Compound heterozygous variants are loss of function variants in different positions of the same gene that,
when combined in one genotype as one allele carrying variant 1 and the other allele carrying variant 2,
cause disease. When both variants are found on the same allele and the other allele is wild type, the
phenotype is normal. VCF.Filter reports only compound heterozygous variants of the first type. The
filtering steps involved are:
1.
2.
3.
4.

Find heterozygous variants in all affected individuals
Test segregation (unaffected parent must not be homozygous for the variant)
Remove single heterozygous variants per gene
Remove compound heterozygotes with genotypes identical to an unaffected individual

3.4.5.4 X-linked variants
Searches for X-linked variants are carried out in male affected individuals according to the pattern:
1. The affected individual is not wild-type the variant position of the X-chromosome
2. The mother is heterozygous at the variant position
3. The father is wild-type at the variant position
3.4.5.5 De novo variants
De novo variants are those variants where the segregation test fails (affected individual’s genotype is not
compatible with genotypes of mother and father), that are not present in any unaffected individual, and
that are not homozygous for the reference allele.
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3.5 Search variants
The Filter and the Family analysis tabs allow the user to get variants from a set of VCF files according to
filter chains and/or family relationships. The search variants tab instead permits searching for given
variants in a cohort of VCF files and to find those VCF files where the variant is present. A typical use-case
is the search for variants reported in a publication in the proprietary cohort. An example search for
variants (carried out when clicking the Example button on the search tab) is shown in Fig. 3.27. The search
starts by loading the VCF files of your cohort in the VCF files section. The variants to search for can be
represented in two ways:
1. ExAC format (chr-position-reference-alternative, e.g. 1-10720305-A-G,
http://exac.broadinstitute.org/)
2. Browser embedded data (bed) format. UCSC style genomic coordinates are also permitted (e.g.
chr1:1-1000000)

Figure 3-27: Example search for variants in the Search tab

VCF.Filter will report all matching variants. Note that if a variant matches both the ExAC as well as the
genomic coordinate’s criteria, the variant will be reported twice for every VCF file it is found in.
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4 Customizing VCF.Filter settings using Preferences
The Preferences allow users to customize a number of settings including output format, default filter
chains, and default directories, which saves time. To open the preferences wizard, use the menu “File” ->
“Preferences” option as shown in Fig. 2.2.

4.1 Files tab
The Files tab allows users to specify five parameters. Only the “Example VCF file” is mandatory to be set
by the user. The Example VCF file is read each time VCF.Filter is started up and the path to this file is
written in the VCFFilter_preferences.ini file. The example VCF files must be indexed and contain all VCF
header lines that are to be used for filtering other cohort VCF files. VCF.Filter uses the header lines of the
example VCF file to initialize filters with the appropriate data type (e.g. String, Float, Integer) and value
number (e.g. 1, A, R), as specified in the header lines.
The “VCF directory” parameter is the
directory where VCF files are stored. The
default is:
Path to VCFFilter.jar/VCFData
The “Frequency files” parameter specifies
the directory where cohort frequency files
in .tsv format are stored. The default is:
Path to
VCFFilter.jar/cohort_frequency_files
The “Inclusion lists” parameter specifies
the directory where inclusion list files in
.bed or .hom format are stored. The
default is:
Path to VCFFilter.jar/list_files
The “Exclusion lists” parameter specifies
the directory where exclusion list files in
.bed or .hom format are stored. The
default is:
Path to VCFFilter.jar/list_files
When these parameters are set, file
choosers will be pointing to these directories whenever VCF files, cohort frequency files, or list file are
loaded.
Figure 4-1: The Preferences Files tab
Hovering the mouse over the “Mouse over
help” provides on-the-fly descriptions of these settings.
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4.2 Filters tab
The Filters tab permits defining the set of filters
that is loaded at start-up. The “Available filters”
section displays the ID field for each VCF header
line whose values can be filtered for. The
“Loaded filters” section displays the ID field for
those VCF header lines that the user wishes to
filter for by default. VCF header line ID fields
can be dragged and dropped back and forth
between the two sections to permit
customization. According to the settings shown
in Fig. 4.2, only the CHROM filter would be
loaded upon VCF.Filter start-up.
Hovering the mouse over the “Mouse over
help” provides on-the-fly descriptions of these
settings.

Figure 4-2: The Preferences Filters tab
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4.3 Filter defaults tab
In the “Filter defaults” tab, default search criteria
can be defined for each VCF header line. The
“Available filters” pull-down menu displays the ID
fields for each VCF header line whose values can
be filtered for. Filter criteria can be defined in the
three text fields for the VCF header line that is
selected in the pull-down menu. When the values
are saved using the “Save” button, a blue writing
appears as confirmation. The settings will be saved
in the VCFFilter_preferences.ini file and used to
initialize the appropriate filters at next start-up.
With the setting shown in Fig. 4.3, The CHROM
filter would be set to filter for variants located on
chr1 or chrX.
Hovering the mouse over the “Mouse over help”
provides on-the-fly descriptions of these settings.

Figure 4-3: The Preferences Filter defaults tab
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4.4 Output format tab
The “Output format” tab permits defining the
set of output columns as well as their order.
The “Available output” section displays all ID
fields of the VCF header lines whose values can
be used for filtering. However, the output for
those values would not be shown unless the ID
is moved to the “Visible output” section by
drag and drop (Fig. 4.4). VCF.Filter reports the
output in the order that is shown in the
“Visible output” section. The order can be
changed by dragging an ID field up or down.
Hovering the mouse over the “Mouse over
help” provides on-the-fly descriptions of these
settings.

Figure 4-4: The Preferences Output format tab
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4.5 Annotations tab
The “Annotations” tab shown in Fig. 4.5 serves
to define the annotation field that lists the gene
symbol of a variant. The gene symbol is required
for compound heterozygous mutant searches
and serves to filter for variants that affect the
same gene. When this field is ill-defined, family
analysis will nevertheless work but a warning
will be displayed that compound heterozygous
mutants cannot be searched for. To define the
gene symbol field, select the appropriate VCF
header line ID from the pull-down menu.
Hovering the mouse over the “Mouse over help”
provides on-the-fly descriptions of these
settings.

Figure 4-5: The Preferences Annotations tab
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4.6 Hyperlinks tab
The Hyperlinks tab shown in Fig. 4.6 can be used to define hyperlinks to websites that provide additional
information regarding a variant. For example, known variants have an ID annotation that lists a dbSNP
identifier. The hyperlink to interrogate the variant rs148410684 at the dbSNP website would be:
https://www.ncbi.nlm.nih.gov/projects/SNP/snp_ref.cgi?searchType=adhoc_search&type=rs&rs=rs148410684
The hyperlink consists of a constant part shown in red and a variable specific part shown in blue. The “hyperlink left”
text field in Fig. 4.6 holds the constant (red) part of the hyperlink. The variable (blue) part is parsed in by VCF.Filter
based on the annotation written in the ID field of the VCF file for each variant and the complete hyperlink is listed in
the output. If the hyperlink also had a constant part to the right of the variant specific part, it should be written in
the “Hyperlink right” text field shown in Fig. 4.6.
The dbSNP hyperlink is provided by default.
When needed, hyperlinks for additional web
resources can be added by pressing the “Add”
button shown in Fig. 4.6, selecting the VCF
header line that holds the annotation for the
variable part of the hyperlink using the pulldown menu, and defining the constant parts to
the left and to the right of the variable part of
the hyperlink. Please note that there may be
web resources requiring more than one variable
part. Currently, such hyperlinks cannot be
configured in VCF.Filter.
To remove a hyperlink, select the VCF header
line in the pull-down menu of the “Add/Remove
hyperlinks” section and press “Remove”.

Hovering the mouse over the “Mouse over
help” provides on-the-fly descriptions of
these settings.

Figure 4-6: The Preferences Hyperlinks tab
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4.7 Application design tab
The “Application design” tab permits choosing between different types of rendering for the graphical user
interface also known as “look and feel”. The default setting is the “Nimbus” look and feel, as shown in Fig.
4.7. Please note that changing the look and feel requires a restart of the application.
Hovering the mouse over the “Mouse over help” provides on-the-fly descriptions of these settings.

Figure 4-7: The Preferences Application design tab
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4.8 Output limit tab
VCF files can be very large. VCF.Filter is a desktop tool that may need more resources than available on
the local computer to process and display all variants. This may lead to unwanted slowdown and even
freezing of the computer. To prevent this from happening, the output limit is set to 500000 variants (Fig.
4.8). When the output limit is reached, VCF.Filter does not process any more variants and the available
output is shown in the output panel. A warning will be displayed making the user aware that the output
is incomplete. Please note that a typical whole genome sequence derived VCF file does not usually contain
many more variants than 500000 for a single individual. Therefore, the output limit of 500000 should be
no limitation for processing exome sequence derived VCF files.
Hovering the mouse over the “Mouse over help” provides on-the-fly descriptions of these settings.

Figure 4-8: The Preferences Output limit tab
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4.9 Making the current settings the default
During a typical VCF.Filter session, the user will define filter chains for different
VCF header lines with different criteria, use multiple input VCF and list files, etc.
In order to make the settings that have been defined available for the next
VCF.Filter session, the user can make the current settings the default settings
that will be written to the VCFFilter_preferences.ini file and loaded at the next
start-up of VCF.Filter. This is accomplished by clicking the “File” -> “Save
settings” menu option as shown in Fig. 4.9. Please note that only the settings Figure 4-9: The “Save
applying to the currently selected main tab (Filter, Family analysis, Search settings” menu
option
variants) will be saved.

4.10 Running VCF.Filter by multiple users
A new VCF.Filter_preferences.ini file is written each time VCF.Filter is shut down and the previous
preferences file is moved to a file called VCFFilter_preferences.ini.bak to preserve functional settings in
case some error occurred during file saving.
When multiple users run VCF.Filter from the same installation directory, the preferred settings of one user
may be overwritten by the settings of another user. To prevent this from happening, VCF.Filter supports
personalized .ini files. To personalize an .ini file, it is sufficient to append the login name of the user to the
preferences file name. For example, the anonymous VCF.Filter preferences file is called
VCFFilter_preferences.ini
Setting up VCF.Filter for personalized use by users hmueller and cbock, create two preferences files by
copying the anonymous preferences file and call them:
VCFFilter_preferences_hmueller.ini
VCFFilter_preferences_cbock.ini
Personalized .ini files have precedence over anonymous .ini files and will be used when the login name of
the user is part of a personalized preferences file. When the login name of the user does not match any
login name of all personalized .ini files in the VCF.Filter installation directory, the anonymous .ini file will
be used. It is worth noting that users can share their settings by sharing their .ini files.
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4.11 Indexing text VCF files
Sometimes a user is faced with a VCF file in text format that was edited and that must be indexed before
it can be loaded into VCF.Filter for further analysis. VCF.Filter provides a menu option that creates VCF
index files for multiple (well-formed) text VCF files without the need to use command line tools (Fig. 4.10).
The indexed VCF files will be written to the directory where the input .vcf files are located. For example,
for the input .vcf file called
Input.vcf
VCF.Filter will create the files:
Input.vcf_indexed.vcf
and
Input.vcf_indexed.vcf.idx

Input.vcf_indexed.vcf can then be loaded into VCF.Filter for further analysis.

Figure 4-10: Indexing VCF files menu option

5 License information
VCF.Filter source code is released under GPLv3 license.
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